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PowerRIP 2000 turns your ink jet printer into a PostScript® Level 3 compatible printer. PowerRIP 2000, a software
raster image processor (RIP) for the Macintosh® computer, reads and interprets PostScript 3 and allows your printer
to print color raster images. 

PostScript is the standard for high quality graphic output. All elements of a document, including text, graphics, and
images are described by the PostScript code. When you print from an application, such as PageMaker,® PowerRIP
2000 processes the PostScript code and sends the processed image to the printer.
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PowerRIP 2000 Features

= PostScript Level 3 compatible

= Mac USB and Ethernet support for most printers

= ColorSync support

= Accepts User Defined ICC Profiles

= ICC profiles for the printers inks and papers as well as 
iProof Systems’ PressProof stock, at all available 
resolutions

= User definable spot colors and color calibration controls

= Makes composites from separations

= DCS1 and DCS2 support

= Prints Acrobat PDF and EPS files by dropping into printer 
queue

= Override printing options embedded in PostScript files

= Network ready, Server/Client and cross-platform 
configurable

= SWOP, Euro, and Toyo color simulation for more accurate 
offset press proof color matching

= Chooser level printer selection on the Macintosh platform

= Disc Cache

= PowerRIP PDF

= RGB Warning

= Print to multiple printers

Chapter 1 - Introduction

Where to get help
For helpful hints and troubleshooting guidelines, see
Chapter10. If you need further assistance, technical sup-
port is available from iProof Systems. 
When calling for technical assistance, be ready to identi-
fy your system and its configuration, the product code of
PowerRIP 2000, and a description of the problems you
are encountering. It is highly recommended that you
enable the Log Messages option when creating a
PowerRIP 2000 printer. The entries in the log will help
the support staff identify PostScript error messages.

iProof Systems Technical Support
iProof Systems Technical Support is available through
phone, fax, mail, e-mail and the Internet. Hours of oper-
ation are 9:00 am to 6:00 pm EST (Monday through
Friday). Free telephone support is limited to 30 days
after your first support call. After 30 days from your
first call, a charge of $25.00 (U.S. Dollars) applies per
incident (billed to your credit card). Visa, MasterCard
and American Express are accepted. We suggest using
iProof’s free e-mail support to get a prompt answer to
any questions you may have.

iProof Systems 
2401 West Eau Gallie Blvd, Suite 4
Melbourne, FL 32935 USA
Telephone Support: (321) 254-6898
Fax Support: (321) 254-6899

Electronic Support Services

n World Wide Web
iProof Systems’ World Wide Web site is 
http://www.iproofsystems.com. iProof Systems’ home
page includes FAQs (Frequently Asked Questions), 
new product announcements, Error Messages, Read 
Me files, and other helpful information. 
n iProof Systems E-Mail Support

You can also send e-mail to iProof Systems at 
Support@iProofSystems.com. Please include your 
name, PowerRIP 2000 Product Code, platform, and 
printer model so that iProof Systems technical sup
port representatives can e-mail a response to your 
question.



7. The PowerRIP 2000 
splash screen will 
display.
Click Continue.

8. The End User 
License Agreement 
dialog display.
Click Accept.

9. The PowerRIP
2000 Installer 
will display. Use 
the Custom 
Install pull-down
to select Full 
Install if you 
want to install PowerRIP 2000 for all printers. 
If you wish to Custom Install for your printer(s) 
only, click on the arrow (4) to the left of Custom 
Install to open, and select your printer(s).

The default is to install the PowerRIP 2000 files in 
the PowerRIP 2000 folder on your startup hard 
drive. If you want to install 
the files else where, change 
the destination.
Click Install.

10.The PowerRIP Installer dia-
log will display and 
PowerRIP 2000 will install.

The program installs all files necessary to run 
PowerRIP 2000. Most files are copied to the folder 
you specified, but the PPDs are copied to the 
System Folder>Extensions>Printer Descriptions 
folder.

11.When the installation is complete click Quit. 
12.Eject the PowerRIP 2000 CD. You may enable your 

virus protection software at this time.
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Installation consists of the following steps:
1. Connect your printer to your Macintosh.
2. Install the PowerRIP 2000 software.
3. Validate PowerRIP 2000.

Before you install PowerRIP 2000, make sure your
Macintosh meets the system requirements which can be
found in PowerRIP System Requirements, this manual.

Installing the PowerRIP 2000
Software
Follow the instructions below for the type of installation
you want: PowerRIP 2000 Full Install (All Printers),
Custom Install, or Client Install. Select Full Install to
install the software for all the printers supported by
PowerRIP 2000 or Custom Install to install the software
for only the printers you have. 

Install PowerRIP 2000 
Follow these steps:
1. Turn off all virus protection programs before you 

install the software. If you do not know how to do 
this, see your virus protection or Macintosh 
documentation.

2. Make sure your printer is turned on.
3. Reboot your Macintosh.
4. Go to the Chooser and click the AppleTalk Active 

button.
5. Insert the PowerRIP 2000 CD-ROM into the CD-

ROM drive.
6. Double-click the PowerRIP 2000 installer icon.

The Select a Language
dialog will display.
Type your Product 
Code. All caps should 
be used. 
Click OK.

Chapter 2 - Installing PowerRIP 2000



13.Omit this step if you have a USB stand-alone con-
figuration. In the Apple menu, select Control Panels, 
then select AppleTalk. For Ethernet Network connec-
tions, select Ethernet. For serial connection select 
Remote Only.

14.Close the window and Save the configuration.

You have completed the PowerRIP 2000 client software
installation. You must now validate PowerRIP 2000. If
you want to use the Pantone or ColorSync color match-
ing system, see Color Matching, this manual. If you
want to print to PowerRIP 2000 from networked
Macintosh computers, see Client Installation, this manu-
al. Otherwise, continue with validating PowerRIP 2000
and then Chapter 3, Getting Started.

Client Install
For a PowerRIP 2000 client installation, follow the
steps 1 through 8 of the Custom Install directions.
9. The PowerRIP

2000 Installer 
will display.
Select Client 
Install.
Click Install.

Follow steps 10 through 14 to complete the install.

Validating PowerRIP 2000
Before using PowerRIP 2000, you must validate your
copy of the software on your standalone or print server
Macintosh. If you do not validate your copy of
PowerRIP, “PowerRIP” will print across your output.
You do not need to validate the software on the
PowerRIP client. PowerRIP 2000 must be launched to
validate your copy. Go to the PowerRIP 2000 folder on
your hard drive. Open the PowerRIP 2000 folder.
Double click on the PowerRIP 2000 application icon.
The PowerRIP 2000 Control Panel will display on the
screen. Follow the steps below:
1. Pull down the File menu and select Install

Validation. The PowerRIP 2000 validation dialog
will display.

2. Write down your
unique User
Code. similar to
this dialog.

Note: The User Code
can change so previous User Codes may not be valid.
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3. You will also need your Product Code which can
be found on the Product ID card inside the software
package.

4. To obtain your Activation Code, launch your web 
browser and enter 

http://www.iproofsystem.com
Click Epson Printers on the iProof home page. In 
the top right corner of the Product information page
click Get and Activation Code. 

5. The Validation page will display. Select English 
as your language. The Online Registration and 
Validation window will display. Fill out the regis-
tration information and click Submit Form.

6. The Validation page will display. 
Click on Validate PowerRIP 2000 Enter your 
Product Code and User Code then click  Submit.

7. Your Activation Code will appear on the next 
screen. Write down that code and quit your 
browser.

8. Enter the Activation Code in the PowerRIP 2000 
Validation dialog Activation box and click OK.

Note: This Activation code can only be used with 
your present User Code. It can not be used 
with any other User Code.

PowerRIP 2000 is now Validated. If you pull down the
PowerRIP 2000 File menu you will note that Install
Validation is now grayed out and Remove Validation is
active. 
Note: The Install Validation process allows up to five 

validations. When you install PowerRIP 2000 for
the first time, and Install Validation, the number 
of available validations will be reset to four. 
When you Remove Validation, the counter is 
reset back to five. There is no limit to the amount
of times you may Install Validation, providing 
you Remove Validation first. You may also check 
your remaining validations on the iProof 
Systems validation web page.

If you do not remember to put your validation
back in your WEB account when you do a remove
validation you will loose that validation. If you
loose all 5 of your validations and require addi-
tional validation you will have to call the iProof
System sales department for additional valida-
tions. There will be a charge for the additional
validations.
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4. Write down the removal code, launch your web
browser and enter:
http://www.iproofsystems.com/
Click Epson Printers on the iProof home page. In 
the top right corner of the Product information 
page click Get and Activation Code. 

6. The Validation page will display. Select English 
as your language. The Online Registration and 
Validation window will display. Fill out the regis-
tration information and click Submit Form.

7. The Validation page will display. 
Click on Remove a Validation. Enter your 
Product Code and Remove Code then click  
Submit.
Your Validation has been put back in your valida-
tion web account.

Remove Validation
You should Remove Validation before reformatting your
hard drive, upgrading your operating system, or upgrad-
ing to a newer computer. 
To Remove Validation follow the steps below:
1. Launch PowerRIP 2000.
2. Pull down the File menu and select Remove

Validation.
3. A warning message appears: “You are about to

remove validation. Are you sure you want to do
this?” Click OK.

4. When you clicked OK in the previous step the
Removal Code is displayed on your screen and a
Simple Text document, Removal.Code, is placed
in the PowerRIP 2000 folder. Double click to open
this document.



This chapter tells you how to launch PowerRIP 2000,
create a PowerRIP 2000 printers, and select a PPD.

Launching PowerRIP 2000
Follow these steps:
1. Make sure your printer(s) are connected to your

Macintosh and the printer(s) are turned on. (See
Chapter 5 for Connecting your Printer to your
Macintosh).

2. Open the PowerRIP 2000 folder on your hard drive.
3. Make sure your Macintosh has the correct connec-

tion selected. (See Chapter 5 for Operating System
Requirements.)

4. Double-click the PowerRIP 2000 icon.

5. The PowerRIP 2000 Control Panel dialog will start
to display. Note: This window is always open while
PowerRIP 2000 is running. See the Chapter 7 for
information about the Control Panel and its
options.

A dialog will display asking you to name your
Message Log. It is  wise to retain the name
“Message Log” and save the log in your PowerRIP
2000 folder.
Click Save.

6. A dialog will display asking if you would like to
search for available printers.
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Click Search
Note: For further discussion on manually creating
queues and Search for Printers see Creating
Printer Queues, this chapter.

7. The Auto Queue Setup dialog will display.
PowerRIP 2000 will search and find all printers
with a direct connection and/or a network connec-
tion. Click OK.

Note: Search for Printers will occur automatically 
at initial install. After initial install Search for 
Printers can be executed from the PowerRIP
2000 Control Panel dialog. See Creating Printer 
Queues, this Chapter, for additional information 
on Search for Printers within the Control Panel 
dialog.

In you have one printer:
It is recommended that you save your printer queue
folder to the desktop. If you have a single printer
you can launch PowerRIP 2000 from the printer
queue folder instead of the PowerRIP 2000 folder
on your hard drive. Double clicking on the printer
icon in the printer queue folder will launch
PowerRIP 2000 and automatically open the printer
queue.

Chapter 3 - Getting Started



If you have multiple printers:
A printer queue will be created for each printer that
is selected in the dialog. If you do not want to cre-
ate a printer queue for all the printers deselect those
printers. To deselect click on the check box to
remove the check.
Click Save.

After creating your printer queue(s) you need to select
the appropriate PostScript Printer Description (PPD) for
your printer. Continue with the next section Selecting a
PPD. Then proceed to Chapter 4, Printing Using
PowerRIP 2000.

Selecting a PPD
A PPD is a description of the characteristics of your
printer. It is used by the PostScript driver and your
application to identify these characteristics when you
print. 

Note: In the QuarkXPress Page Setup dialog, you must 
select a PPD from the Printer Description pull-
down menu. The printer description will begin 
with iProof PowerRIP followed by the specific 
printer name.

Never select third party PPDs. Always select the appro-
priate PPD for your printer that was installed by
PowerRIP 2000. The PPDs can be found in System>
Extensions>Printer Descriptions.

To Select a PPD follow the steps below:
Note: PowerRIP 2000 must be launched and the printer

queue must be active to select a PPD when using
LaserWriter 8.

1. Open the Chooser from the Apple Menu. 
2. Select LaserWriter 8. Your printer appears on the

right. Highlight it.

3. Click Create. The following dialog box appears: 
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If Desktop Printer Spooler is not enabled, or if you
previously have created the Desktop Printer, the
Create button in step 3 above is replaced by the
Setup button. In that case click Setup.
Note: Menus and PPD selection may vary, 

depending upon your Macintosh OS and the 
version of LaserWriter 8 you are using. 

4. Click Select PPD... A list of PPDs appears. (If you
don’t see the PPD for your printer, you may need to
scroll through the list or select Other PPD.)

5. Highlight the PPD for your printer and click 
Select. If Desktop Printer Spooler is enabled a dia--
log will display on the screen telling you a Desktop
Printer is being built.

6. A dialog will display stating that you have changed
your current printer. Click OK. Close the Chooser.

You have now created a printer queue and selected the
PPD for your printer. Continue with Chapter 4, printing
from PowerRIP 2000.

Note: Refer to the Read Me PDFs/Desktop Printers.pdf
on the PowerRIP 2000 CD for detailed informa-
tion on network printing and DeskTop Printers.

Creating Printer Queues
There are two methods which can be used to create
your queue(s). You can create your queue manually or
automatically with Search for Printers.

Search for Printers
Search for Printers will search and find all printers sup-
ported by PowerRIP 2000 with a direct connection
and/or a network connection. All printers must have
been turned on before Search for Printers occurs.

Note: Search for Printers will occur automatically at
initial install. After initial install Search for 
Printers can be executed from the PowerRIP
2000 Control dialog. 

Search for Printers can be used with one printer con-
nected to a USB port, printers connected via a network,
or a combination of USB and network printers. The
cable or network connection used will be defined in the
queue name. If you have two of the same printer types
it will define the first printer with the printer name, the
second printer with the printer name and a 1 and so on. 

Once you have created your printer queues with Search
for Printers, in the future when launching PowerRIP
2000, all the printers will automatically open. But you
must remember to turn your printers on before launch-
ing. If a printer is removed from the network or has not
been turned on before PowerRIP 2000 is launched you

Setting Up” My Printer”.



will get an error message to that effect and can skip that
printer. Also if you close a printer using Printers>Close
Printer in the PowerRIP Control dialog, the next time
you launch PowerRIP 2000 the printers will not auto-
matically open.

Using Search for Printers
Go to File>New Printer>Search for Printers. A
search will commence.

Follow step 7 page 9 to create your printer queues.

Manually Creating Printer Queues
To manually create a printer queue follow the steps
below:
1. In the PowerRIP 2000 Control dialog go to 

File>New Printer
Select the sub menu for your printer
Select the appropriate connection for your printer
i.e., USB, Serial Port,or LocalTalk/EtherTalk.

2. The Printer Setup dialog will display.

You will see different dialogs for different connec-
tions. For an in-depth discussion of the Setup dialog 
features for your printer, see Chapter 7 Printer 
Setup. Click OK.

3. A dialog box will display allowing you to name your
printer queue.
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Name your printer queue (or leave the default name) 
and select a location for the printer queue folder. A
good location for the printer queue folder is in the 
PowerRIP 2000 folder. The name of the printer 
queue folder will have to “q” added to it, for exam-
ple,”My Printer q.”

Note:If you save the printer queue to the desktop 
you can launch PowerRIP 2000 from the 
queue folder instead of the PowerRIP 2000 
folder on your hard drive. Double clicking 
on the printer icon in the queue folder will 
launch PowerRIP 2000 and automatically 
open the printer queue.

4. Click Save. The PowerRIP 2000 Control Panel dis-
plays the printer queue you just created at the bot-
tom of the PowerRIP Control Panel dialog.

You have completed creating the printer queue. You
need to select the appropriate PostScript Printer
Description (PPD) for your printer, page 10, and
the proceed to Chapter 4, Printing Using PowerRIP
2000.

Printing from a Client Macintosh to a
Windows NT Server
If you are printing from a Macintosh client to a
Windows NT server you must use the Windows PPDs
which are on the PowerRIP 2000 CD in the folder
PPD>US. Manually insert the PPD(s) for your printer(s)
into the Printer Descriptions folder of the System
Folder>Extensions on your client Macintosh.

Networking Macintosh computers to
Windows NT Server 4.0
Note: To print from a Macintosh client to a Windows

PowerRIP 2000 server you must be running
under Windows NT Server 4.0 with Services for
Mac installed or Windows 2000 Professional.

1. Open the Chooser and select LaserWriter 8. The
printer appears on the right. Highlight it. Click
Setup or Create. Create will display the first time
you go to the Chooser. Setup will display thereafter.

2. A LaserWriter dialog will display. Click Select PPD.
3. In the Select a PostScript Printer Description file

dialog select the PPD that you copied from the
PowerRIP 2000 PC PPD folder. Click Select. Close
the Chooser. 

You are now ready to print from your Macintosh appli-
cations to your PowerRIP 2000 on your server PC. For
directions for printing from specific applications go to
the Read Me PDF files on the PowerRIP 2000 CD.



This chapter includes instructions for printing, can-
celling, and deleting print jobs.

Printing from a Standalone or Server
Macintosh
When you use PowerRIP 2000 to print from a stan-
dalone or server Macintosh, you are actually creating a
PostScript file from your application, sending it to
PowerRIP 2000 to be processed, and then send the pro-
cessed file to your printer.

Note: Do not drop PostScript files in the System soft-
ware Print Spooler or Print Monitor printer icon,
on your desktop. Files must be spooled to the
PowerRIP 2000 printer queue folder.

The PostScript files must be saved to the printer queue
folder you created earlier. If you saved the PostScript
file to a different destination, you can drag and drop the
file into the proper printer queue folder. Do not save
jobs to the Printed Jobs folder inside the printer queue;
jobs reside there after they have printed.

If your Macintosh has sufficient memory, you can keep
PowerRIP 2000 open  in the background while you
work in other applications. Your print job starts process-
ing as soon as it gets to the printer queue.

If you don’t have enough memory (your Macintosh will
tell you whether or not you do), save your files to your
printer queue folder, quit your application, and then
launch PowerRIP 2000 and the printer (printer queue)
to print.

Preparing PowerRIP 2000 to Print
Follow these steps:
1. Make sure that the correct PPD is selected in the

Chooser using LaserWriter 8, and Setup. Also make
sure you have the correct network selected.  (See
Chapter 5 for network and cable connection 
information.)

2. Open the PowerRIP 2000 folder on your hard drive
and double-click the PowerRIP 2000 icon to launch
the application and open the PowerRIP 2000 Control
Panel. 

Note: If you saved your printer queue folder on the
desktop, open the printer queue folder, double
click on the printer icon. 

Your printer(s) will automatically open. 
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If you close your printers manually in the PowerRIP
2000 Control dialog using Printer>Close Printer before
you Quit PowerRIP 2000 you will have to manually
open your printers the next time you launch PowerRIP
2000.

To manually open Printers:
1. From the File menu, select Open Printer.
2. Select your printer queue folder (you may need to

navigate to it) and click Open. 
3. Select your printer and click Open.

Printing from Your Application
Printing from PowerRIP 2000
On the PowerRIP 2000 CD, there is a folder called
Read Me PDFs. This folder contains Read Me files that
will walk you through printing from most major appli-
cations using the LaserWriter 8 and AdobePS8 drivers.
Drag the Read Me file you wish to print, to the
PowerRIP 2000 printer queue folder. The Read Me will
process and print. 

Print Menu Options
Most applications have printer dialog boxes that allow
you to select the printing options for your printer. These
options are usually accessed through the Printer
Specific Options in the printer dialog pull-down box.
For an in-depth discussion of the Printer Specific
Options please see Chapter 8.

Note: See the PageMaker Read Me in Read Me PDFs
for Options when printing from PageMaker.

Cancelling a Print Job
In PowerRIP 2000, cancelling stops the current job
from printing, and puts it in the Completed Jobs folder.
To cancel the current print job, click the Cancel Print
button in the center of the PowerRIP 2000 Control
Panel, then click Yes.

When you cancel a job you will get a Interrupt Error in
the PowerRIP 2000 Control Panel message window,
this is normal.

Cancelled print jobs go into the Completed Jobs folder
and can be printed at a later time. To do this, select
Show Completed Jobs under the Printer pull-down
menu at the top of the screen. Select the print job and
click the Reprint Job  button. The job will reappear in

Chapter 4 - Printing Using PowerRIP 2000



the Control Panel job queue, process and print. If you
want to delete the print job, follow the steps in the next
section, “Deleting a Print Job.”

If there are other print jobs besides the current job that
you don’t want to print, follow the steps in the next
section, “Deleting a Print Job.” 

Deleting a Print Job
Deleting a print job removes it from the queue folder
and Completed Jobs folder. Follow these steps:

1. In the PowerRIP 2000 Control Panel, select the print
job you want to delete.

2. From the Print Job menu, select Remove job. Your
print job is deleted from the print queue folder. You
may also delete a job from the queue or Completed
Jobs folder by highlighting it and pressing zk.

iProof Systems, Inc. 12 PowerRIP 2000 Manual
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Chapter 5 includes system requirements for all supported printers and information for connecting your printer to
your Macintosh.

Standalone/Print Server Macintosh RAM and Disk Space Requirements

RAM

Minimum:
At least 64 MB of RAM
Preferred:
128 MB of RAM

Minimum: At least 256 MB
of RAM
Preferred: 512 MB of RAM

At least 96 MB

Disk Space

At least 200 MB (approximately 24
MB required for a Custom Install).

At least 2 GB 

At least 200 MB. Full Install (All
Printers) requires approximately 20
MB for the PowerRIP 2000 appli-
cation alone.

Operating System Requirements

Printers

Epson 
(Stand alone or Print Server
Mac)

HP
(Stand alone or Print Server
Mac)

Operating System

OS 8.1 or later. (OS 9 or
later supported.)

OS 8.1 or later. (OS 9 or
later supported.)

CD-ROM

Required

Required

AppleTalk Network

AppleTalk network connection
required if Server Mac

AppleTalk network connection
required if Server Mac

Printers

Epson Stylus Color, Color II, IIs, 500, 600, 680,
740, 760, 777, 800, 850, 860, 880, 900, 1160,
1500, 1520, 3000, C80, C70, C60, 680

Epson Stylus Pro, Pro XL, Pro XL+, 5000, 777,
880, 980, 5500

Epson Stylus Photo, Photo EX, EX3, 700, 780,
790, 750, 870, 875, 890, 1200, 1270, 1280, 1290,
2000P, 810, 820

Epson Stylus Scan 2000, 2500

Epson Stylus Pro 7000, 7500, 9000, 9500, 10000,
1000CF

HP 900 series
(Includes the 930C, 932C, 935C, 950C, 952C,
970Cse, 970Cxi)

HP 1220 series
(Includes the 1220C, 1220Cse, 1220Cxi)

Chapter 5 - PowerRIP 2000 System Requirements
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Client Macintosh

RAM and Disk Space Requirements

Operating System Requirements

Printers

Epson Stylus Color, Color II, IIs, 500, 600, 680, 740, 760,
777, 800, 850, 860, 880, 900, 1160, 1500, 1520, 3000, C80,
C70, C60, 680
Epson Stylus Pro, Pro XL, Pro XL+, 5000, 777, 880, 980,
5500
Epson Stylus Photo, Photo EX, EX3, 700, 780, 790, 750,
870, 875, 890, 1200, 1270, 1280, 1290, 2000P, 810 820
Epson Stylus Scan 2000, 2500

Epson Stylus Pro 7000, 7500, 9000, 9500, 10000, 10000CF

HP 900 series
(Includes the 930C, 932C, 935C, 950C, 952C, 970Cse,
970Cxi)

HP 1220 series
(Includes the 1220C, 1220Cse, 1220Cxi)

RAM

At least 64MB of RAM

At least 96 MB of RAM

At least 24 MB

Disk Space

N/A

N/A

N/A

Printers

Epson 
(Client Mac)

HP
(Client Mac)

Operating System

OS 8.1 or later. (OS 9 or
later supported.)

OS 8.1 or later. (OS 9 or
later supported.)

CD-ROM

Required

Required

AppleTalk Network

AppleTalk network connection
with the PowerRIP server

AppleTalk network connection
with the PowerRIP server
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Connecting Your Printer to Your Macintosh

Printer

Epson printers

HP printers

Printer Dependent Interfaces Supported

Serial connection Use printer port or modem port.
If you use the modem port your modem software must be disabled.

Note: If you are cable connected via the printer or modem port choose your printer model and Serial
Port, when creating a new printer.

Optional LocalTalk, EtherTalk Interface card, or AXIS 1440 print server - Follow the instruc-
tions in the printer and interface manuals for installing, connecting, and naming your printer. 

Note: If you have an Ethernet or LocalTalk interface or a AXIS or Jet Direct print server, choose 
your printer model and LocalTalk/EtherTalk when creating your new printer.

USB to Parallel adapter - If your printer does not have a USB port.
Note: The Epson Stylus Color, Pro, ProXL, Color 500, and Stylus 1500 do not support USB to 

Parallel.

If you are cable connected via USB, which includes USB to Parallel adapter, choose your 
printer model and USB when you create a new printer.

USB
USB to Parallel

Note: If you are cable connected via USB, choose your printer model and USB when you create a 
new printer.

Ethernet via Jet Direct Print Server

Note: If you have a Jet Direct print server, choose your printer model and LocalTalk/EtherTalk when 
creating your new printer.
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Chapter 6 includes information about ColorSync, Pantone,
Calibration, and Define Spot Colors.

Note: The features discussed in Chapter 6 are dependent on 
your printer and version of PowerRIP 2000. Not all 
features are available on all printers or on all revi-
sions of PowerRIP 2000.

ColorSync Support
ICC profiles are color space definitions. The ICC profile for-
mat is defined by the International Color Consortium as a
cross platform standard. The ability to cross platform allows
you to print from the Macintosh to the PC, or the PC to the
Macintosh. ICC compliant applications, such as Photoshop
5.x, Illustrator 8.x, QuarkXPress 4.x, have the capacity to
output using ColorSync 2.6 or later. PowerRIP 2000 can
print using ColorSync from any ICC compliant application. 

PowerRIP 2000 comes standard with ICC profiles for all the
printers that PowerRIP 2000 supports. They can be found in
the ICC folder on the PowerRIP 2000 CD. These ICC pro-
files have been specifically created for the PowerRIP 2000.
Create a temporary folder on your hard drive, open the ICCs
folder on the PowerRIP 2000 CD and drag the ICCs for your
specific printer(s) to the temporary folder you just created.
The ICCs are self extracting archives; double click to extract
the files. Use the ICC profiles in applications that support
ColorSync 2.6 or later. Refer to the ColorSync ICC.pdf to
install and use the ICCs (Read Me PDFs folder on the
PowerRIP 2000 CD). The abbreviations used to define the
ICC profiles can be found in a Simple Text ICC Read Me in
the ICC folder on the PowerRIP 2000 CD.

If you have created customized ICC profiles to meet your
unique printing needs, the Add ICCs feature of PowerRIP
2000 can be used to customize your PPD to accommodate
your specific needs. (See page 20 for Using Your
Customized PPDs)

Using Your Own Custom ICC Profiles 
Using ICCToColorSpace gives you the ability to append
your custom ICC profiles to both the PowerRIP 2000 and the
PPD (PostScript Printer Description), for your printer. Once
you have appended your custom ICC profile to the PPD, you
have created your own customized PPD. You can put a copy
of that customized PPD on all the Macintosh computers in
your company, to assure that all files are output with the

same profiles. Your customized PPD can also
accompany your file wherever it goes, to assure it
is always being printed with the correct ICC pro-
file. You have to ability to append as many cus-
tomized ICC profiles to the PPD and PowerRIP
2000 as your needs require. 

Note: ICCToColorSpace is located in the Tools 
folder in your PowerRIP 2000 folder. Your 
custom ICC profiles should be saved in the 
ColorSync Profiles folder, in the System 
folder.

To customize your PPD and PowerRIP 2000
1. Launch ICCToColorSpace.
2. The Open dialog will display asking you to:

Choose a Source Profile
Note: ICCToColorSpace automatically defaults 

to the ColorSync Profiles folder. If your 
customized ICC profile is located in a 
folder other than the ColorSync Profiles 
folder use the pull-down to navigate to it.

Highlight your customized ICC profile. 
Click Open.

3. The Save dialog will display asking you to:
Create a CMYK Color Space Resource
or
Create an RGB ColorSpace Resource
This dialog depends on the type of source pro-
file you selected. You can give this resource a 
descriptive name or maintain the current name. 
Wordspaces cannot be used in the name. Use an 
underline in lieu of a wordspace. For this exam-
ple the descriptive name E1160_ICC_PM will 
be used.

Chapter 6 - Color Matching



Note: If you have more that one PowerRIP 2000 installed 
on your Macintosh hard drive, navigate to the appro-
priate PowerRIP 2000 folder>Jaws folder>Resources
folder>ColorSpace folder

Click Save. 
The ICCToColorSpace window will close. 
You have appended your ICC profile to your PowerRIP
2000 and your PPD. Repeat this process for each ICC 
profile that you wish to append to the PPD and 
PowerRIP 2000. You can append as many customized 
ICC profiles to the PPD and PowerRIP as your needs 
require.

Using your Customized Profile
When you want to use your customized profile you have
two options. You can either go to Printer Specific Options
in the applications
print dialog or you
can click on the
printer name in the
PowerRIP 2000 Control Panel. The Setup dialog will dis-
play. Click on Define Printer Settings and using the
CMYK
Source
pull
down
select your custom profile. Click Force Printer Settings.
Click OK. Click OK. Your file will be printed using your
custom profile.
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PANTONE™ Color Support for the Stylus
Pro and Pro XL

The Pantone Matching System (PMS) is the most com-
monly used of all the ink mixing systems. PowerRIP 2000
is Pantone certified for the EPSON Stylus Pro, and Pro XL
and Pro XL+. 

For all other printers, using a PANTONE™-licensed appli-
cation, you can define a new spot color by adding the
name of the Pantone color in the Edit Color portion of the
application. The word Pantone must be in initial caps, a
space, the number of the color, a space, and the appropri-
ate extension i.e., Pantone 7449 CVU. You must also
make sure that you select CMYK as the color model and
define the color as a spot color. Do not define the percent-
age of CMYK.

You can also create your own special named colors in
LAB, RGB, or CMYK color spaces using Define Spot
Color.

When printing using named spot colors you must select
separations in the Print dialog and Make Composite from
Separations in Printer Specific Options. This feature can
only be used with applications that have the ability to
select separations in the Print dialog. If you are using an
application that required your selecting separations in
Printer Specific Options then this application can not cre-
ate Composites from Separations. 

The Pantone files for the EPSON Pro, Pro XL, and Pro
XL+ are included with PowerRIP 2000. These files can be
read directly into all PANTONE-licensed applications so
you can have printer calibrated versions of all Pantone col-
ors. The colors are calibrated to use PowerRIP 2000’s
stochastic screens, PressProof and EPSON’s papers.

For installation instructions, refer to the Read Me First
file, Pantone Documentation, and Pantone Manual in the
Pantone folder on the PowerRIP 2000 CD.

Define Spot Color
Inks in color printing fall into two categories: process
color and spot color. The process inks are Cyan Magenta
Yellow K Black (CMYK).  Spot color inks can be virtual-

or



ly any color. The most widely used spot color system being
the Pantone Matching System. Spot colors are special pre-
mixed colors that require their own separations.

Process colors and spot colors may appear on the same
page. Spot color is generally used when a particular color
match must occur, such as a company logo or product
brochure. If you print your spot colors as a process separa-
tion the color might not be an accurate color match. The
named color will be converted to a percentage of CMYK,
which means you no longer can guarantee the color match.

Spot colors are special premixed inks with specified CMYK
equivalents instead of process (CMYK) color inks. Define
Spot Color allows you to print spot colors so that they are
not converted to process color when
printed. If you print your spot colors
without using Define Spot Color, all your
spot colors will print as process color.
Define Spot Color can also be used to
redefine a color if you find that the names color you have
chosen does not meet your specific color needs.

Create your file and select the named colors you wish to
print. Then using Define Spot Color, you can define the spot
colors in PowerRIP 2000 to assure that they will not be
printed as process spot colors. If you are going to use the
same spot colors with many files, it would be wise to create
a printer queue specifically for your spot color output. For
this discussion we will create a new printer specifically for
the spot colors.

Defining your Spot Color in PowerRIP 2000
1. Launch PowerRIP 2000.
2. Create a new printer queue. (See page 11 for creating a 

new printer)
The Setup dialog will display. Select a realistic time for 
Purge Printer Jobs After and a realistic number for 
Limit Post-print Queue to. 

3. Click Define Spot Colors. The Main Setup dialog will 
display.

Select Yes to Make Composites from Separations.
Select Force Printer Settings.
Click OK.

4. Click OK to close the Setup dialog. 
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5. Save your printer with a name that defines it as 
your spot color queue.

Printing using Define Spot Color
When you print your file that contains the spot col-
ors you will select print as separations in your
application. But since you will be printing this file
to your spot color printer queue and it is setup to
make composites from separations the following
will occur:
1. The application will spool the separations to 

PowerRIP 2000 spot color queue. PowerRIP
2000 will start to build the composite from the 
separations. As it is processing the first spot 
color the following dialog will display:

Click Yes.
2. The Add Spot Color dialog will display.

Define the percentage of C, M, Y, and K for the 
spot color. Click OK. The next spot color will 
display. Repeat steps 2 & 3 for each spot color.

Note: After you have finished printing your spot 
colors using your spot color queue you must 
remember to go back to your previous print-
er queue. If you use your spot color queue 
for your normal printing all future output 
will be printed in black and white. If you 
want to use your spot color queue for all 
your printing then you will have to go to 
Define Printer Setting and deselect Force 
Printer Setting and click Reset Defaults. 

Calibration
PowerRIP 2000 has the ability to adjust color using
either Output Calibration and/or Dot Gain Curves.
This gives the user the ability to increase or
decrease the color intensity. The user can adjust all
colors or each color individually. There is a folder
on the PowerRIP 2000 CD called Read Me PDFs.
This folder contains a Calibration Read Me file in
PDF format. Refer to the Calibration Read Me for
in-depth instructions on its use.
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Note: The features discussed in Chapter 7 are dependent on your printer and version of PowerRIP 2000. Not all 
features are available on all printers or on all revisions of PowerRIP 2000.

PowerRIP 2000 Files
When you installed PowerRIP 2000, files, folders, and subfolders were copied to the PowerRIP 2000 folder you
specified. Never remove or modify these files.

Printer Setup (Epson Printers)
When you created your PowerRIP 2000 printer queue for your printer, a Setup dialog will display. The setup dialog
varies depending on the printer you are using and how you are cable connected to that printer. (See page 11 for cre-
ating printer queues.)

USB Setup
Lists the printers on-line via
USB. If more than one printer
appears in the list, select the one
your are creating
a Queue for.

AppleTalk Setup
If you have installed Ethertalk via Jet Direct Print
Server, Axis 1440 Print Server, or an optional
LocalTalk card in your printer and selected New
Print, LocalTalk/ Ethertalk should be selected.
The Setup screen will display the Printer Name
box. Search will automatically enter the proper
name in this box.

Search
Click this button to search for your printer’s net-
work name. Never change the name the Search
has found.

Search for ‘LaserWriter’

If Search does not find the printer connection,
check this button and click Search again. 

Serial Port Setup
Make sure the serial (printer or
modem) port your printer is con-
nected to is selected.

Chapter 7 - Printer Setup Dialogs/Control Panel Options
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Printer Setup (HP Printers)
When you created your PowerRIP 2000 printer queue for your printer, a Setup dialog will display. The setup dialog
varies depending on the printer you are using and how you are cable connected to that printer. (See page 11 for cre-
ating printer queues.)

USB Setup
Lists the printers on-line via USB. If more than
one printer appears in the list, select the one you
are creating a Queue for.

AppleTalk /EtherTalk
The printer name will be automatically dis-
played when you click the Search button. Do
not alter this name or you will not be able to
communicate with the printer. 

Search
Click this button to search for your printer’s
network name. Never change the name the
Search has found.

Search for ‘LaserWriter’

If Search does not find the printer connection,
check this button and click Search again. 



Printer Setup (All Printers)
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Purge printed jobs after

Limit post-print queue to 

Use Output Calibration

Use Dot Gain Curves

Define Spot Colors

Define Printer Settings

Page Setup

When checked, jobs are deleted from the Printed Files subfolder for
this PowerRIP 2000 printer after the specified number of seconds,
minutes, hours, days, or weeks. When not checked, there is no time
limit on jobs already printed.

When checked, the oldest jobs are removed from the Printed Files
subfolder for this PowerRIP 2000 printer when the specified number
of jobs is exceeded. When not checked, there is no maximum num-
ber of jobs already printed.

Recommended for use with ink jet printers. Allows you to increase
or decrease color intensity of all colors or any of the CMYK chan-
nels you want to modify. Click this button to access the Define
Calibration menu.

Recommended for use only with densitometers and PowerRIP
2000’s dot gain values on ink jet printers. Click this button to access
the Define Curves menu.

Gives you the ability to output spot colors in any color or combina-
tion of colors you define. Click this button to access the Define Spot
Colors menu. (See Chapter 6 Matching for Define Spot Color
directions.)

When you click the Define Printer Settings button the Main dialog
will display allowing you to make changes to Printer Specific
Options previously selected. If “Force  Printer Settings” is checked,
this feature gives you the ability to override the printing options
embedded in a PostScript file. You can reprint a low resolution 
PostScript file from the Completed Jobs folder at a higher resolution.
Select the new printing options you desire, Click “Force Printer
Setting” and click OK. You can also create multiple queues for the
same printer specifying your desired printing options for each; elimi-
nating the need to select the options in your print menu. A complete
list of the individual settings can be found in Chapter 8. 

Reset to Defaults - Clicking this button causes the printing options
to be reset back to the default setting whether Force Printer 
Settings is checked or not.

Allows you to change the paper size and the paper type (printer
dependent) of a previously printed file, if Force Printer Settings is
selected.



job status This is a single character in the far left column of the list.

H the job is held
h the printer is held
F the job failed
• the job is currently processing
* the job is currently being cancelled
blank the job is ready to print

job name This is the name of the original job, not necessarily the name of the PostScript file you created.

created This is the date and time that the job was created.

for This is the name of the user who created the print job.

printer This is the name of the PowerRIP 2000 printer on which the job will be printed.

pages This is the number of pages in the job. If no page count is specified in the job, the page count 
starts at 1 and increments as each page of the job is processed.

size This is size of the job.
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PowerRIP 2000 Control Panel
The PowerRIP 2000 Control Panel, shown below, is displayed when you launch PowerRIP 2000.

Pre-Print Queue 
The pre-print queue list is the large window in the top of the PowerRIP 2000 Control Panel window. When files are
in the queue each line in the list is a print job for an open printer and includes the following information: 

Jobs that are not held are printed in the order in which they appear in the list. To modify this order, hold down the
option key and drag a job up or down to a new position in the list.

Processing Bar

Pre-Print Queue

Message Log

Queue List

PowerRIP PDF 45 min 00
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Printer Control Buttons

Hold Printer/ This button is a shortcut for the Hold Printer and Release Printer commands in the Printer
Release Printer menu. When the printer selected in the Printer List is held, this button changes to Release 

Printer. The currently printing job will not be held.

Hold Job/ This button is a shortcut for the Hold Job and Release Job commands in the Print Job menu.
Release Job When the job selected in the Pre-Print Queue is held, this button changes to Release Job.

Cancel Job This button is a shortcut for the Cancel Job command in the Print Job menu.

Print This button is a shortcut for the Print Job, Pause Printing, and Resume Printing commands 
in the Print Job menu. When the job selected in the Pre-Print Queue is printing, this 
button changes to Pause; when the selected job is paused, this button changes to Resume. 
Double-clicking on a job in the Pre-Print Queue or selecting a job and typing Return or 
Enter is identical to clicking on this button.

Message Log
Message logs are files created by PowerRIP 2000 for reviewing RIP activities such as printing times, error mes-
sages, etc. These message logs can be opened in a word processing application. You will need a word processor to
open the logs if they get too large. To create a new message log select New Log file in the PowerRIP 2000 
File menu.

Messages This displays all informational and error messages generated by PowerRIP 2000 since its 
launch.

Log Messages This check box is a shortcut for the Log Messages command in the File menu. 

Speak Urgent This check box is visible only when optional speech recognition software is installed on the
Message PowerRIP 2000 server. When checked, critical warning messages written to the Message 

Log View are also spoken. This is useful if you wish to be informed of status when not sit-
ting at the PowerRIP 2000 server.

Queue List
The Printers list is the window in the bottom of the PowerRIP 2000 Control Panel window. Each open printer is
displayed in this window. When there is no character to the left of the printer name, the printer is ready to print.
The following characters can appear at the left of the printer name. 

H the printer is held
S the printer is starting up
C the printer is closing

Note: Double-clicking on a printer name in the Printers list is a shortcut for the Setup Printer command in the 
Printer menu.
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Printer Specify Options Epson Only

Note: The features discussed in Chapter 8 are dependent on your printer and version of PowerRIP 2000. Not all 
features are available on all printers or on all revisions of PowerRIP 2000.

Option

Resolution

Paper Type

Cache to Disk
Before Printing

Settings

Printer’s Default (360 dpi),
180 dpi, 360 dpi, 720 dpi,
1440 dpi, 2880 dpi.
Note: Resolution is printer
dependent.

Plain Paper, 360 Coated
Paper, Transparency, Photo
Quality Paper, High Quality
Paper, Glossy Paper, Glossy
Film, Press Proof 2, Photo 
Paper, Double Weight Matte
Paper (Roll), Synthetic Paper,
Watercolor Paper, Glossy
Paper (Roll), Premium
Glossy Photo Paper (Roll),
Semigloss Photo Paper
(Roll),  and many more.

Yes or No

Description

Resolution of printed images is measured in Resolution of
printed images is measured in dots per inch (DPI) and
represents the amount of detail that can be shown. The
higher the number, the finer the resolution. Lower reso-
lutions print faster and use less ink. Note: Resolution is
paper type and printer dependent.

Select the paper type you are printing on. PowerRIP
2000’s Color Rendering Dictionaries (CRDs) are based
upon the printers special paper stocks. These CRDs pro-
duce the maximum output quality on the selected paper.
Paper type is, printer and resolution dependent Caution:
Using other brands of paper will result in inferior output
quality.

Cache to Disk Before Printing requires a large amount of
free contiguous hard drive space on your startup drive.
This feature should be used when printing very large
posters (up to 20 ft long) on the large format printers.
Cache to Disk Before Printing precesses the file, saves
the file to disk, and prints one continuous output stream.
After printing is finished the cache file is automatically
removed from the hard disk.

Chapter 8 - Printer Specific Options
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Printer Specify Options HP Only

Option

Print Mode

Paper Type

Duplexing

Color Gamut

Settings

Color-Normal, Color-Draft,
Color-Best, Color-PhotpREt,
High Resolution Color

Plain Paper, PressProof 2,
Bright White Inkjet Paper,
Premium Inkjet Paper,
Premium Inkjet Heavyweight
Paper, Photo Paper,Premium 
Photo Paper Glossy, Premium
Plus Photo Paper Glossy,
Premium Plus Photo Paper
Matte, Premium Inkjet
Transparency Film, Banner
Paper, Matte Greeting Card,
Glossy Greeting Card, Felt-tex-
tured Greeting Card,
Professional Brochure & Flyer
Paper Glossy & Matte, Iron-On
T-Shirt  Transfer, Restickable 
Large Square & Round Inkjet
Stickers, and many more.

Book Style
Tablet Style

Max Gamut, SWOP Simulated,
Euro Simulated.

Description

The Print Mode selected is predicated on the paper
selected. If you make a selection in Print Mode
that does not match your Paper Type you will get
an error message telling you the selection is not
compatible with the Paper Type you have selected.

Select the paper type you are printing on
PowerRIP 2000’s Color Rendering Dictionaries
(CRDs) are based upon the printers special paper
stocks. These CRDs produce the maximum output
quality on the selected paper. Paper type is, printer
and resolution dependent. Caution: Using other
brands of paper will result in inferior output
quality.

Select No unless you want to print two sided out-
put. You must have the Duplex option.

Gamut is the total range of colors reproduced by a
device. A typical CMYK gamut is generally small-
er than a typical RGB gamut.
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Printer Specify Options All Printers

Option

Rendering Intent

RGB Source

CMYK Source

Make Composites
from  Separations

Generate Pure
Black

Screening

Print Direction

Settings

Document Defined, Perceptual,
Absolute Saturation,Relative
Saturation, Relative
Colorimetric, Absolute
Colorimetric. 

Document Defined, RIP Default,
Normal, Apple 13RGB
Stand,Apple Multi Scan 17 plus
many more. 

RGB Warning

Document Defined, RIP Default,
Japan S,SWOP, Euro LWCP
Less than 70g, Euro Mat Paper
above 70g, Euro Gloss Paper
Above 70g. Euro uncoated white
offset, TOYO

No or Yes

No or Yes

Stochastic Always
Application’s Default

Unidirectional
Bi-directional

Description

A Color Management Module. The specific Management
software component in a Color System that maps, or
translates the color space of one device to another using
ICC device profiles (e.g. ColorSync or Kodak CMS).
See Glossary for specific definitions. 
Note: Absolute & Relative Saturation and Relative &
Absolute Colorimetric are not available at this time.

Display profiles for monitors. These profiles describe the
characteristics and color gamuts enabling the CMS to
convert between a monitor’s native color space and a
device-independent reference color space.

If you print a CMYK as an RGB in error it will print off
color to alert you to the setup mistake.

Output profiles for devices such as printers and printing
presses. Also know as destination profiles. PowerRIP
2000’s Color Management System uses these profiles so
that the output on your printer is representative of
the color qualities you can expect if your job is printed
on an offset press.

Allows you to print composite proofs directly from color
separated (DCS) output files.

If Yes is selected blacks will print directly from the
black ink cartridge. If No is selected blacks will be cre-
ated using C, M, and Y. Note: Selecting Yes may have
adverse effects on halftones.
Note: Some applications such as QuarkXPress do not
preserve pure black in gradients.

Stochastic Screening is a random dot pattern that pro-
duces more tones and has more detail than fixed screen
rulings.

Can be  set to Unidirectional or Bi-directional. Bi-direc-
tional, or high speed mode, is faster and does not signifi-
cantly decreased print quality.
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Printer Specify Options PowerRIP PDF Only

Option

Resolution

ASCII Format

Auto-Rotate

Compressed PDF

Create Thumbnails

Preserve Halftone Info

Device Dependent Color

Convert CMYK Images to
RGB

Transfer Function

Under Color Removal
(UCR)

Sub-Sample Images

Sub-Sample Resolution

Description

The available resolutions are 72, 144, 288, 300, 600, 1200, and 2400 dpi. It
should be noted that selecting a higher resolution can significantly increase the
PDF file size.

ASCII Format allows you to save files in ASCII format but it should be noted
that the ASCII Format will create a slightly larger file.

Auto-Rotate rotates a file from portrait to landscape.

Compressed PDF compresses document such as books and manuals to create a
smaller PDF file. The appropriate compression method is one that creates the
smallest PDF as possible, with the highest possible quality.

Thumbnails are very small page representations that aid the user in navigating
through multi-page documents, and provide an easy method for moving and
copying pages within a document.

Select Preserve Halftone Information when you want to retain the halftone
(screening) information.

Select Device Dependent Color to use the PowerRIP PDF color corrected
information when creating PDFs.

Select Convert CMYK Images to RGB if you want RGB images when the
PDF is created.

Remove will remove the curves in the file when making the PDF. When the
PDF is opened in Acrobat the change in the file can be seen on the screen.
Apply will use the curves in the file when making the PDF. When the PDF is
opened in Acrobat the change in the file can be seen on the screen.
Preserve uses the curves in the file when making the PDF. When the PDF is
opened in Acrobat the no change in the file can be seen on the screen.

Remove removes UCR when creating the PDF.
Preserve retains the UCR information when creating the PDF.

If you select None no sub-sampling will occur. Subsample reduces the amount
of data in the image to no more than what the PDF needs.
Average averages the pixels and replaces them with the average pixel color at
the specified resolution.

Resolution should be defined when using Average in Sub-Sample Images.
Select the lowest resolution possible. Selecting a high resolution will greatly
increase the time it takes to process and print the file. The available resolutions
are 72, 100, 150, 200, and 300 dpi (Dots Per Inch).
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Printer Specify Options PowerRIP PDF Only (Cont)

Option

Compress Images

Preserve OPI Comments

Preserve Overprinting
Settings

Embed All Fonts

Description

If you select None no compression will occur.
JPEG compression creates a much smaller file size because it eliminates data.
JPEG compression can affect image quality.
ZIP compression does not remove data to reduce the file size so it does not
affect the image quality.

Preserve OPI Comments retains the information needed to replace the FPO
(For Placement Only) image with a high resolution image located on a server
that supports OPI.

Preserve Overprinting Settings retains the overprint settings in the file being
converted to a PDF.

Select Yes to Embed All Fonts if you want all the fonts in your system, embed-
ded in the PDF.



PowerRIP PDF is the ideal utility for creating high
quality, platform independent PDFs. You can take
advantage of all your applications, various features and
attributes, combined with the feature intensive
PowerRIP PDF, giving you complete flexibility to cre-
ate PDFs that meet your particular needs. These PDFs
being small in size and platform independent can be
viewed on both the Macintosh or PC, can be used as e-
mail attachments, or web site documents. 

Adobe Acrobat Reader 3.0 or later should be installed
on your system to so that Auto Open can occur after the
PDF is created. Acrobat 4.0 recommended.

PowerRIP PDF Queue 
When you launched PowerRIP 2000 for the first time
and did a Search for Printers a PowerRIP PDF queue
was created. If you choose not to create a PowerRIP
PDF queue at initial install then you need to create a
queue before using PowerRIP PDF. 

To create a PowerRIP PDF queue launch PowerRIP
2000. In the PowerRIP Control dialog go to File>New
Printer>PowerRIP PDF. The PowerRIP PDF Setup
dialog will display.

If you created a PowerRIP PDF queue at initial install
launch PowerRIP 2000. Double click on PowerRIP
PDF in the Printers portion of the PowerRIP Control
dialog. The PowerRIP PDF Setup dialog will display.

PowerRIP PDF Setup Dialog
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Select the features that will meet your PDF needs. The
features are as follows:

When Purge printed jobs after is selected, PDFs are
deleted from the PDF folder after the specified number
of seconds, minutes, hours, days, or weeks. When not
checked there is no time limit on the jobs in the folder.
Select how long you want to keep your PDFs.

When Limit post-print queue to is selected, the oldest
PDFs are removed from the PDF folder when the speci-
fied number of jobs is exceeded. When not checked,
there is no maximum number of PDFs saved. Select the
number of  PDFs, you want to save.

Use Output Calibration allows you to increase or
decrease color intensity of all colors or any of the
CMYK channels you want to modify. Click this button
to access Define Calibration.
Note: For a complete discussion of calibration read the

Calibration Read Me which can be found in the 
PowerRIP PDF folder.

Use Dot Gain Curve is recommended for use only
with a densitiomter. Click Use Dot Gain Curves to
access the Define Curves menu.
Note: For a complete discussion of Dot Gain Curve 

read he Calibration Read Me which can be found
in the PowerRIP PDF folder.

When you click the Define Printer Settings the
PowerRIP PDF Printer Settings dialog will display. 

Chapter 9 - PowerRIP PDF



This  dialog allowing
you to make changes to
Printer Specific Options
previously selected. If
“Force Printer Settings”
is checked, this feature
gives you the ability to
override the options
embedded in the file.
You can recreate a low

resolution file from the Completed Jobs folder at a
higher resolution. Select the new options you desire,
Click “Force Printer Setting” and click OK. You can
also create multiple queues specifying your desired
options for each; eliminating the need to select the
options in your print menu. A complete list of the indi-
vidual settings can be found in Chapter 8 - Printer
Specific Options.

Page Setup allows you to change the paper size and the
paper type (printer dependent) of a previously printed
file, if Force Printer Settings is selected.

Job Name+.PPD creates the PDF using the job name.
File Name+.PPD creates the PDF using the name of
the file. User Defined should be selected if you want to
type a new file name for the PDF.

Select Prompt User if the file or job already exists in
your PDF folder.
Select Overwrite Existing File if the file or job name
already exists in your PDF folder. The new file or job
of the same name will overwrite the previous file.
Select Auto Rename if the file or job name already
exists in the PDF folder. The PDF will be saved with a
number added to the name. (Example: ticket#2.PDF)
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Click Change Output Folder to create a folder for
your PDFs and queue. You should create a folder to
hold all your PDFs. Click Change Output Folder. The
Select a Folder dialog will display. Navigate to where
you want the new folder saved. Click New Folder. The
Name of new folder dialog will display. Give your new
folder a name. Click Create. (For this exercise the new
folder is called PDFs.) The Select a Folder dialog will
redisplay. On the bottom of this dialog you will see
Select PDFs Click Select PDFs.  The name you gave
your folder will replace PDFs which is the name we
gave the folder for this exercise.  The PowerRIP PDF
Setup dialog will redisplay. You will notice that in the
box under Output Folder your new folder has been
selected.

If you select Auto Open Generated PDF the PDF will
automatically be opened in Acrobat as soon as
PowerRIP PDF is finished creating the PDF file. You
must have Acrobat installed on your system for this
function to be available.

Click Font Embedding if you want to embed fonts
with the PDF. The Font Embedding dialog will display.

When you select Embed all fonts, all the fonts on your
system are embedded in the PDF when it is created.



Select Subset Fonts if you have created a list of fonts
in Always Embed. The subset you have created will
always be embedded in the PDF, when it is created.

To create a subset of fonts select Subset fonts. Click on
the Always Embed portion of the display to make it
active. Click Add. The Add Font dialog will display.
Type the name of the font. Click OK. You will see the
font name in the Always Embed window. To delete a
font from this list highlight the font and click Remove.

If you select Use Original TrueType fonts, True Type
fonts will be embedded as Type 42 PostScript fonts
regardless if you have TrueType substitution turned on
or off.

If you select Never Embed the subset of fonts you cre-
ate will never be embedded in the PDF. To create a sub-
set of fonts to never embed select Subset fonts. Click
on the Never Embed portion of the display to make it
active. Click Add. The Add Font dialog will display.
Type the name of the font. Click OK. You will see the
font name in the Never Embed window. To delete a
font from this list highlight the font 

Click OK to exit Font Embedding.
Click OK to exit the PowerRIP PDF Setup dialog if
you are editing an existing queue. If you are creating
your queue a window will display asking you to name
the queue.  The queue will be saved in the folder we
made when we did Change Output Folder. 

Selecting a PPD
A PPD is a description of the characteristics of your
PowerRIP PDF. It is used by the PostScript driver and
your application to identify these characteristics when
you create a PDF 

Never select third party PPDs. Always select PowerRIP
PDF PPD that was installed by PowerRIP PDF. The
PowerPDF.PPD can be found in System>Extensions>
Printer Descriptions.

To Select PowerPDF.PPD follow the steps below:

Note: PowerRIP 2000 must be launched and the PDF
queue must be active to select the PPD when
using LaserWriter 8.

1. Open the Chooser from the Apple Menu. 
2. Select LaserWriter 8. Your PDF Queue appears on

the right. Highlight it.
3. Click Create. 
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The first time you select the PPD it will say Create.
If the Desktop Print, Spooler is not enabled, or if
you previously have created the Desktop Printer
Create is replaced by the Setup button. In that case
click Setup.

4. Click Select PPD.  A list of PPDs appears. (If you
don’t see the PowerPDF.PPD, you may need to
scroll through the list or select Other PPD.)

5. Highlight PowerPDF.PPD and click Select. If
Desktop Printer Spooler is enabled a dialog will dis-
play on the screen telling you a Desktop Printer is
being built.

6. A dialog will display stating that you have changed
your current printer. Click OK. Close the Chooser.

You have created or edited a PDF queue and selected
the PPD. You are now ready to create PDFs. 

Creating PDFs from within Applications
You can create a PDF from within your application by
simply selecting PowerRIP PDF PPD which will give
you all of the PowerRIP PDF features right within the
application Print dialog. For this discussion a PDF will
be created in QuarkXPress 4.x, PageMaker 6.5, and
Photoshop 5.x. These three applications will give you
the understanding necessary to create PDFs from with-
in all your applications.

Creating a PDF in QuarkXPress 4.x

Note: It is assumed that your QuarkXPress file is on the
screen and ready to create a PDF.

1. Select the PowerRIP PDF PPD in the Chooser. 
2. Go to File>Page Setup. The Quark Print dialog will

display.
Setup tab

Select PowerRIP PDF in Printer Description.
Select the correct Paper Size and Page Positioning.
Select the pages you want included in the PDF.



Document tab

Deselect Include Blank Pages.
3. Click Page Setup in the bottom left corner of the 

Print dialog. 

The LaserWriter Page Setup dialog will display.
Page Attributes
Select the correct orientation and scaling.
Click OK. The Quark Print dialog will redisplay.

4. Click Printer in the bottom left corner of the Quark 
Print dialog.

5. The LaserWriter Print dialog will display.
Save as File

Select Level 2 and 3 in PostScript Level, Binary in 
Data Format, and ALL in Font Inclusion

Printer Specific Options 1
Select the applicable Options. 
Note: See Chapter 8 - Printer Specific Options this 

manual for complete descriptions of all the 
available options.
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Printer Specific Options 2
Select the applicable Options. 

Printer Specific Options 3
Select the applicable Options. 

Click Print.
Click Print.

If you had selected Auto Open Generated PDF in the
PowerRIP PDF Setup dialog, PowerRIP PDF will pro-
cess the file, create the PDF, save it in your PDF 
folder and automatically launch Acrobat and display
the PDF. If you did not select Auto Open Generated
PDF you can go to your PDF folder and click on the 
PDF to launch Acrobat and open the PDF.

Creating a PDF in PageMaker 6.5

Note: It is assumed that your PageMaker file is on the 
screen and ready to create a PDF.

1. Select the PowerRIP PDF PPD in the Chooser. 
2. Go to File>Print. The Print Document dialog will 

display. Make sure that the correct PPD is selected 
in PPD.

3. Click Features. 
The Print Features dialog will display.

PowerRIP PDF

PowerRIP PDF.PPD



Note: This is a scrollable window.
Select the applicable Features. (See Chapter 8 - 
Printer Specific Options this manual for complete 
descriptions of all the available options.

4. Click Color
The Print Color dialog will display. Make sure 
Composite and Color are selected.
Click Print

If you had selected Auto Open Generated PDF in the
PowerRIP PDF Setup dialog, PowerRIP PDF will pro-
cess the file, create the PDF, save it in your PDF 
folder and automatically launch Acrobat and display the
PDF. If you did not select Auto Open Generated PDF
you can go to your PDF folder and click on the PDF to
launch Acrobat and open the PDF.

Creating a PDF in Photoshop 5.x

Note: It is assumed that your Photoshop file is on the 
screen and ready to create a PDF.

1. Select the PowerRIP PDF PPD in the Chooser. 
2. Go to File>Print. The LaserWriter Print dialog will 

display.

Note: See Chapter 8 - Printer Specific Options this 
manual for complete descriptions of all the 
available options.

Printer Specific Options 1
Select the applicable Options. 
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Printer Specific Options 2
Select the applicable Options.

Printer Specific Options 3
Select the applicable Options. 

Click Print.
Click Print.

If you had selected Auto Open Generated PDF in the
PowerRIP PDF Setup dialog, PowerRIP PDF will pro-
cess the file, create  PDF, save it in your PDF folder 
and automatically launch Acrobat and display the PDF.
If you did not select Auto Open Generated PDF you
can go to your PDF folder and click on it to launch 
Acrobat and open the PDF.
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Note: The features discussed in Chapter 10 are dependent on your printer and version of PowerRIP 2000. Not all
features are available on all printers or on all revisions of PowerRIP 2000.

This troubleshooting guide lists possible solutions for common problems. Please refer to the troubleshooting hints
before calling technical support. When calling for technical assistance, be ready to identify your system and its con-
figuration, the product code of PowerRIP 2000, and a description of the problems you are encountering. It is highly
recommended that you enable the Log Messages option when creating a PowerRIP 2000 printer. The entries in the
log will help the support staff to identify PostScript error messages.

Note: On PowerRIP 2000 CD  there is a folder called Read Me PDFs. This folder contains in-depth Error
Messages and Frequently Asked Questions (FAQ) Read Me’s. 

Troubleshooting Hints
This section includes the most common situations PowerRIP 2000 users encounter. Each problem includes several
possible solutions. 

Problem

Demo prints across your page

Out of Memory, Memory Low, and VM
Error Messages

Font not found: using Helvetica;
Findfont errors

Images on printed pages are clipping

Solution

• PowerRIP 2000 has not been validated. See Validating 
PowerRIP 2000 instructions on page 8.

• Install additional memory.
• Turn Virtual Memory On. Refer to Macintosh Help or your 

Apple documentation.

• In your application’s Print Menu when selecting Save as File, 
you should select “All” in the Font Inclusion pull-down menu.

• Select Always download needed fonts under the General pull-
down in your application’s print menu.

• Are you allowing Font Substitution in your page setups? If so, 
turn Font Substitution off.

• Make sure you have PostScript-compatible printer fonts rather 
than just screen fonts. If you do not have PostScript-compatible
printer fonts loaded on your system, you cannot print them.

• Make sure your fonts are available to the system. In order to be 
available, fonts must be placed in the Fonts subfolder inside the
System Folder. No other subfolder should be placed within the 
main font subfolder. If your font library is too extensive to be 
placed in the Fonts subfolder, you might consider purchasing 
Suitcase,™ a font handling utility. 

• Open the Preferences subfolder inside the System Folder and 
delete the PowerRIP™ Preferences file. A new preference file is
automatically created when you restart PowerRIP 2000.

• Consider the printable image area of your printer. You may 
need to increase your margins or decrease the size of your 
image. 

Chapter 10 - Troubleshooting
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Troubleshooting Hints (Cont)

Problem

Images on printed pages are clipping
(Cont)

Printer out of synch – outputting repeat-
ed pages of extraneous code

Printer cannot be opened/printer not
found/problem with printer

Job in pre-print queue not printed

Job does not appear in pre-print queue

Job prints in black and white or one or
more colors are missing

Solution

• Make sure you selected the proper PPD in the Chooser Setup.

• If Cancel Job or Hold Printer have no effect, turn off your print-
er to avoid wasting paper.

• Force Quit the PowerRIP 2000 application. Do this by holding 
down the option and command keys and then pressing the 
escape key to Force Quit. You must then reboot your Macintosh
to re-establish communication with the printer.

• Make sure the printer is powered on.
• Make sure the printer is connected properly to the PowerRIP

2000 server. Defective cables are a common problem. Try a
different cable.

• If you are using an EtherTalk interface via HP Jet Direct Print 
Server, make sure you did not alter the name of the interface 
that the Search recorded. 

• If you are connected via USB or USB to Parallel ensure that 
you have an Epson USB driver active in your System Folder/ 
Extensions. USB drivers for Epson printers are available on the 
web at www.Epson.com. An Epson USB driver is not necessary
with Macintosh OS 9’s USB Driver Extension.

• If you are using EPSON’s optional LocalTalk or EtherTalk 
interface card, or an Epson AXIS 1400 Print Server, make sure 
you did not alter the name of the interface that the Search 
recorded.

• Make sure the PowerRIP 2000 printer is not held, starting up, or
closing.

• Make sure the job is set up to print to the correct PowerRIP
2000 printer. 

• Make sure the printer is connected properly to the Macintosh.
• Make sure the Epson printer is ready and the Pause light is off.

• Make sure the PowerRIP 2000 printer for the job is open.
• Make sure the job was placed in the proper queue. When creating

a PostScript file, you must save it to the printer queue folder you
set up. If you saved it to another location, you can drag it into 
the proper print queue folder.

• Make sure the correct printer has been selected in the Chooser 
on the client Macintosh.

• Make sure both the PowerRIP 2000 server and client are on the 
same network.

• Make sure you specified color output in your application’s print
dialog. 
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Troubleshooting Hints (Cont)

Problem

Job prints in black and white or one or
more colors are missing (Cont)

Job just printed not in post-print queue

Client times out while sending job to
PowerRIP 2000

Rendering stopped or slower than
normal

Solution

• Check the color ink cartridge. If the cartridge is empty, replace 
the cartridge according to the instructions in your printer 
documentation.

• If you specified a purge time of 0 in the Printer Setup dialog for
the PowerRIP 2000 printer, the job is purged as soon as it fin-
ishes printing. If you want to keep printed jobs, change the 
purge time.

• If you specified a maximum job count of 0 in the Printer Setup 
dialog for the PowerRIP 2000 printer, no jobs are saved after 
they are printed. If you want to keep printed jobs, change the 
maximum job count.

• Did you switch to another application on the PowerRIP 2000 
server? If you did, the other application may not give PowerRIP
2000 enough time to maintain its connection with the client. 
Switch back to PowerRIP 2000 and try printing again.

• Is PowerRIP 2000 running on a slower Macintosh computer, 
and are there several clients trying to print to PowerRIP 2000 
simultaneously? Your server may not be fast enough to support 
a large number of simultaneous transfers. Wait for some of the 
clients to completely send their jobs to PowerRIP 2000, then try
again.

• Instead of printing directly to the server Macintosh select Save 
in the client’s Print Menu. Save the PostScript file on the client 
Macintosh and manually drag it to the server’s print queue.

• Increase PowerRIP 2000’s memory allotment. To do this quit 
PowerRIP 2000, highlight the PowerRIP 2000 icon, under the 
File menu select Get Info/Memory. Change Preferred Size to a 
greater number, keeping in mind the total amount of RAM you 
have, the RAM requirements of your operating system and all 
applications you might have active at any one time.

• On slower Macintosh computers, transfer operations may 
require most of the available memory; therefore, rendering dur-
ing transfers slows down considerably. Make sure multiple 
clients do not send jobs at the same time.

• Make sure all PowerRIP 2000 dialog boxes are closed. If they 
are open, and waiting for a reply, rendering is suspended until 
the dialog is closed. 



Glossary

Absolute A rendering intent where colors match exactly with no Colorimetric adjustment made for white 
point or black point that would alter the image’s brightness. 

AdobePS™ A printer driver used by an application to create a driver PostScript file. This driver is distribut-
ed by Adobe and may be used as a substitute for a LaserWriter driver. 

Calibration The process of setting a device, such as a monitor or  printer, to known color conditions.

Color space A particular variant of a color model with a specific gamut or range of colors which is one of its
chief characteristics.

CMM Color Management Module. This software component in a CMS does the color conversion cal-
culations from one device’s color space to another’s.

CMS Color Management System. This is a tool that maps, or translates the color space of one device 
to the color space of another. ColorSync on the Macintosh and ICM on Windows are examples 
of CMSs.

ColorSync A system-level CMS developed by Apple Computer for the Macintosh OS.

FPU Floating Point Unit. A chip capable of executing operations with real numbers. The FPU may 
be built-in (MC 68040 or PPC 601) or available as an add-on to the main CPU (MC 68881).

framing The process by which a complete raster image of a page is created in memory before it is out-
put to an imaging device. If the available memory is sufficient, then PowerRIP 2000 will frame 
a page. Since disk spooling of bands is unnecessary, framing is usually faster than banding.

ICC The International Color Consortium. A group of industry vendors that have agreed to a standard 
color matching system for device profiles, color management system architecture, and 
components.

imaging device A device capable of printing a raster image on a physical medium, for example, a printer, or 
imagesetter.

interpreter A set of software functions to convert PostScript language commands into a raster image. 

job A file containing PostScript language operators and operands residing in a Jobs folder and listed
in either the Pre-Print Queue or the Post-Print Queue.

LaserWriter™ A printer driver distributed by Apple Computer and used by an application to create a PostScript
file describing the visible contents of a document.

Message Log A scrolling text view in the PowerRIP 2000 control panel containing all logged messages.

network EtherTalk or AppleTalk cabling and required software to link Macintosh computers to each 
other, or in the case of PowerRIP 2000, to link the clients to the server.
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Perceptual A rendering intent which compresses the total gamut from one device’s color space when one or
more of the colors in the original image is out of the gamut of the destination color space.

Post-print queue A scrolling list in the PowerRIP 2000 Completed Jobs window containing all jobs already print-
ed for all open PowerRIP 2000 printers.

PostScript An interpretive programming language developed by Adobe that describes the text, graphics, 
and image content of a document.

PowerRIP 2000 A Macintosh computer on which the user runs most applications. The user may print from these
client applications to an imaging device attached to a PowerRIP 2000 server.

PowerRIP 2000 The main window of the PowerRIP 2000 application containing Control Panel the control but
tons, Pre-Print Queue, the message log view, and the printer list.

PowerRIP 2000 A virtual imaging device representing a physical imaging device with a user-selectable set of
printer characteristics. Each PowerRIP 2000 printer has a separate jobs folder. The names of all open 

PowerRIP 2000 printers appear as LaserWriter devices in the Chooser dialog opened on a 
PowerRIP client.

PowerRIP 2000 A file representing a PowerRIP 2000 printer residing in the Jobs file folder for that queue
queue

PowerRIP 2000 A Macintosh computer running the PowerRIP 2000 application which networked client comput-
server ers print to.

Pre-Print Queue A scrolling list in the PowerRIP 2000 Control Panel Window containing the job currently print-
ing and all jobs yet to be printed for all open PowerRIP 2000 printers.

Printer List A scrolling list in the PowerRIP 2000 Control Panel Window containing all open PowerRIP
2000 printers.

Printer Setup A dialog box in which you select options for a PowerRIP 2000 dialog box printer.

PSPrinter™ driver A printer driver used by an application to create a PostScript file. This driver is distributed by 
Adobe and may be installed as a substitute for a LaserWriter driver. 

queue folder A folder containing a PowerRIP 2000 printer file and all jobs for that printer. Jobs to be printed 
are in the Jobs folder; jobs already printed are in the Printed Files subfolder. 

raster image A bitmap representing an interpreted PostScript page to be output to an imaging device. For 
each device pixel on the page, there is a corresponding color in the color space appropriate for 
the imaging device.

Relative When a color in the current color space is out of gamut in the target color space, it is mapped to
Colorimetric the closest possible color of the target color space while colors that are in gamut are not

affected.

render The process by which PostScript language commands are interpreted and a raster image is 
produced.
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Rendering intent The method a CMM uses for converting colors from one device’s gamut to another. 

RIP Raster Image Processor. An application or device that renders PostScript language inputs and 
outputs the resulting raster image to an imaging device.

SWOP Standard Web Offset Publication. The color matching standard that all printing presses and 
proofing systems in the United States are based upon. 

TIFF Tagged Image File Format. A standard image file format.

White Point How the color white is reproduced. On a monitor it is the combination of Red, Green, and Blue 
phosphors at full intensity. Necessary as a reference point in calibration. 

iProof Systems, Inc. 39 PowerRIP 2000 Manual



Index

A
Add Spot Color  . . . . . . . . . . . . . . . . . . . . . . . . . .18
AppleTalk Setup . . . . . . . . . . . . . . . . . . . . . . . . . .19
ASCII Format . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
Auto-Rotate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27

B
Book Style  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25

C
Cable Connection  . . . . . . . . . . . . . . . . . . . . . . . . .15
Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Cancel Print Job  . . . . . . . . . . . . . . . . . . . . . . . . . .11
Client Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Color Matching  . . . . . . . . . . . . . . . . . . . . . . . . . .16
Color Sync  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16

D
Define Spot Color  . . . . . . . . . . . . . . . . . . . . . . . .17
Delete Print Job  . . . . . . . . . . . . . . . . . . . . . . . . . .12
Disk Space  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Duplexing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25

E
Embed All Fonts . . . . . . . . . . . . . . . . . . . . . . . . . .28
E-mail address  . . . . . . . . . . . . . . . . . . . . . . . . . . . .4
Euro Simulated . . . . . . . . . . . . . . . . . . . . . . . . . .257

F
Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4
FPU  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37
Full Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6

G
Generate Pure Black . . . . . . . . . . . . . . . . . . . . . . .26

H
Help, where to get  . . . . . . . . . . . . . . . . . . . . . . . . .4
Hold Job . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

I
ICCtoColorSpace  . . . . . . . . . . . . . . . . . . . . . . . . .16
Images  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .34
Install PowerRIP  . . . . . . . . . . . . . . . . . . . . . . . . . .5

J
Job Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Job Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

L

iProof Systems, Inc. 40 PowerRIP 2000 Manual

LaserWriter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
Launching PowerRIP  . . . . . . . . . . . . . . . . . . . . . . .8
Limit Post Print Queue  . . . . . . . . . . . . . . . . . . . . .21
Log Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

M
Manually Creating Queues  . . . . . . . . . . . . . . . . . . .9
Message Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

N
Networking

Macintosh to NT Server  . . . . . . . . . . . . . . . . .10
NT Server to Macintosh  . . . . . . . . . . . . . . . . .10

O
Operating System  . . . . . . . . . . . . . . . . . . . . . . . . .14
Out of Memory  . . . . . . . . . . . . . . . . . . . . . . . . . .34
Output Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . .26

P
PowerRIP Features  . . . . . . . . . . . . . . . . . . . . . . . . .4
PPDs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Print Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
Printer Queues  . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Printing from Applications  . . . . . . . . . . . . . . . . . .11

Q
Queues  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Queue List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

R
RAM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Remove Validation  . . . . . . . . . . . . . . . . . . . . . . . . .7
Release Job  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
RGB Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26

S
Search for Printers  . . . . . . . . . . . . . . . . . . . . . . . . .9
Serial Port Setup . . . . . . . . . . . . . . . . . . . . . . . . . .19
Server Macintosh  . . . . . . . . . . . . . . . . . . . . . . . . .11
Standalone  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11

T
Tablet Style  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . .4
Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . .34

U



Under Color Removal  . . . . . . . . . . . . . . . . . . . . .27
USB Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
Use Dot Gain Curve  . . . . . . . . . . . . . . . . . . . . . .213

V
Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Virtual Memory  . . . . . . . . . . . . . . . . . . . . . . . . . .34

W
Web address  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4
Web Install  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Where to get help  . . . . . . . . . . . . . . . . . . . . . . . . . .4

iProof Systems, Inc. 41 PowerRIP 2000 Manual


